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1 Applications

The LED displays can visualize texts and plain
graphics on a matrix of 7 x 120 LEDs (PML-100...)
or 7 x 80 LEDs (PML-60/70...). While the PML-
100R and the PML-60R only provide red LEDs, the
PML-100COL and PML70-COL allow for visualiza-
tions in red, green and orange. The displays can be
operated via the infrared remote control supplied or
via USB using a computer. Up to 26 messages can
be saved on the display. The messages may be
arranged in any order desired and may be en-
dowed with various effects to arouse attention. The
integrated clock allows for a time-controlled display
or for the display of date and time. An internal buffer
battery keeps the data entered and ensures that
the clock continues working for up to 30 days after
the power supply has been disconnected. The PC
program allows users to create their own graphics
and special characters.

2 Safety Notes

These units (display and power supply unit) corre-
spond to all relevant directives of the EU and are
therefore marked with C€.

WARNING The power supply unit uses dange-

rous mains voltage. Leave servicing
to skilled personnel only. Inexpert
handling may result in electric shock.
Please observe the following items in any case:
® The units are suitable for indoor use only. Protect
them against dripping water and splash water,
high air humidity and heat (admissible ambient
temperature range 0—40 °C).

® Do not operate the display and immediately dis-

connect the mains plug from the socket

1. if the units or the mains cable are visibly dam-
aged,

2. if a defect might have occurred after a unit was
dropped or suffered a similar accident,

3. if malfunctions occur.

In any case the units must be repaired by skilled

personnel.

® Never pull the mains cable to disconnect the
mains plug from the socket, always seize the
plug.

® For cleaning only use a dry, soft cloth; never use
water or chemicals.

® No guarantee claims for the units and no liability
for any resulting personal damage or material
damage will be accepted if the units are used for
other purposes than originally intended, if they
are not correctly connected or operated, or if
they are not repaired in an expert way. Likewise,
no liability will be accepted for data loss caused
by operating errors or by a defect or for any con-
sequential damage of this data loss.

hid

If the unit is to be put out of operation defi-
nitively, take it to a local recycling plant for
a disposal which is not harmful to the envi-
ronment.

3 Setting the Display
into Operation

3.1 Mounting

To mount the display to a wall, for example, use
the mounting brackets supplied. Remove the two
screws (3) located on the left and right side of the
display and then use them to fasten the display to
the mounting brackets.

Alternatively, suspend the display by means of
the two eyes (1) located on the left and right side of
the display. The eyes glide out of the display when
the display is turned.

WARNING

A\

Install the display safely and
expertly. When installing the display
at a place where people may walk or
sit under it, equip its mounting with
an additional security mechanism to
prevent it from dropping or make
sure that the mounting cannot get
disengaged.

3.2 Inserting batteries into
the remote control
The battery compartment is located on the bottom
side of the remote control.
1) Press the locking latch of the battery compart-
ment in the direction of the arrow and open the
cover.

2) Insert two batteries of AA size. Observe the
polarity (indicated in the battery compartment).

3) Replace the cover and have the latch engaged.

GE]
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3.3 Connecting the computer

For remote-controlled operation or setup of the dis-
play via a computer, connect the computer by
means of the adapter cable supplied. Connect
the RJ14 plug to the jack RS232 (2) of the display,
and connect the USB plug to a USB port of the
computer.

Note: To make sure that no transmission errors occur, only
use extension cables with signal amplification.

3.4 Mains connection

Connect the low-voltage plug of the power supply
unit (provided with the display) to the port DC IN (4)
and connect the power supply unit to a mains
socket (230 V~/50 Hz), using the mains cable. This
will switch on the display. The system information
(unit type, data transmission rate, address/ID num-
ber, firmware version) will be briefly shown one
after the other and then the message most recently
selected will appear.

3.5 Installing the PC software

The installation of the control program supplied
requires a PC equipped with the Windows 98,
Windows ME, Windows NT, Windows 2000,
Windows XP operating system or later, a memory
of at least 32 MB and a USB interface. To install the
PC software, insert the CD supplied, and then click
“Install Software” on the “Welcome” screen that
automatically appears. If the “Welcome” screen
fails to appear, start the installation program
SETUP.EXE on the CD supplied and follow the
instructions of the installation program.

Windows is a registered trademark of Microsoft Corporation in the United States
and other countries.

3.5.1 Installing the USB driver

The connection via the USB interface requires a
special driver which simulates a serial interface for
the control program. If no appropriate driver is
installed on the computer, install the driver from the
CD supplied.

4 Operation

The display may be operated either via the infrared
remote control supplied or via a computer on which
the control program supplied is installed. The con-
trol program provides some additional functions,
e.g. for creating user-defined graphics or special
characters.

4.1 Operation via IR remote control

To operate the display via the infrared remote con-
trol supplied, align the infrared remote control with
the infrared sensor located next to the LED field.
The display acknowledges each command it
receives from the remote control with a beep.

4.1.1 Switching on/off

The display is always switched on once it has been
connected to the power supply. To switch the dis-
play on or off via the remote control, press the but-
ton [ON/OFF].

4.1.2 Displaying date and time

To alternately display the current date and time
instead of the message, press the button [TIME/
DATE]. To return to the message display, press the
button [ESC].

Date and time adjustment I=5" chapter 4.1.7.1

4.1.3 Quick text entry
To quickly and comfortably enter a one-line text:

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press the button [Q-PROG].
3) Enter the text (1= chapter 4.1.3.1)

4) Press [ENTER] to complete the text entry. The
text entry automatically appears on the display.

4.1.3.1 Textentry

The text (max. 200 characters) is entered by
means of the character buttons [A] to [Z]. Use the
button [SHIFT] to switch between uppercase char-
acters (cursor appears as: “1”), lowercase charac-
ters (“1”), numerals/special characters (white but-
ton labelling, “1") and other special characters
(green button labelling, “I”).

For some characters, variants are available. To
select the variants of a specific character, press the
appropriate character and then (repeatedly) press
the button [EUROP-CHAR]:



Character Variants Character Variants
A AAAARAAE a EEEEEEE:
B B
¢} (¢} c c
D 3]

E EEEE e géés
| i i i
N N n fi

o 0006060 o 066606
P p p b

U uuou u UG
Y Yy y vy

Note: With the PC software, users can overwrite the vari-
ants with their user-defined characters and then retrieve
them via the remote control.

To enter a space character, press [SPACE]; to
delete the last character, press [DEL].

To change the font style (standard: 5x7, con-
densed: 4 x 7 or bold: 6 x 7 = pixels per character:
horizontal x vertical), press [FONT]; to change the
text colour and/or the background colour, press
[COLOR].

4.1.4 Saving texts with effects

26 texts, each with defined fade-in and fade-out
effect, display time and fade-in/fade-out speed,
can be saved as messages on the display. The
texts can be displayed individually or combined in
any order.

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

Press the button [PROG]. “PROG (1/i/=/<)"is
displayed.

n

L

Press [{]. The storage location “PAG A” is dis-
played.

=

Press [—]. “A” is displayed in bold.

o

Press [1] or [{] to select the storage location
(A to Z) and then press [ENTER] to confirm.

Note: A quick text entry (I=° chapter 4.1.3) will over-
write storage location A.

2

Enter the text (1= chapter 4.1.3.1) or no text
(if one of the predefined welcome texts are to
be displayed) and press [ENTER] to confirm.
“—> IMMEDIATE” is displayed.

Press [1] or [{] to select the fade-in effect or one
of the predefined welcome texts (“Welcome” or
“Hello World”) and then press [ENTER] to con-
firm. “< IMMEDIATE” is displayed.

J

N

The following fade-in effects are available:

IMMEDIATE immediate text display without any
fade-in effect

XOPEN fade-in from the centre to the cor-
ners

CURTAIN UP fade-in from the bottom to the top

CURTAIN DOWN fade-in from the top to the bottom

SCROLL LEFT  scroll-in from right to left

SCROLL RIGHT
VOPEN

scroll-in from left to right
fade-in from the centre to the top
and to the bottom

VCLOSE fade-in from the top and the bottom
to the centre

SCROLL UP scroll-in from the bottom to the top

SCROLL DOWN  scroll-in from the top to the bottom

SNOW dots dropping from the top (like
snow)

TWINKLE twinkle effect with changing colours

BLOCK MOVE scroll-in of blocks from the right

RANDOM random appearance of the individ-
ual pixels

HELLO WORLD text “Hello World” in handwriting
font style

WELCOME text “Welcome” in handwriting font

style

Note: If the text is longer than the display, use the fade-
in effect “SCROLL LEFT” to show the entire text.

Press [1] or [{] to select the fade-out effect and
then press [ENTER] to confirm. “STAY 00.5 Sec”

is displayed.

The following fade-out effects are available:

IMMEDIATE the text disappears without any
effect

XOPEN fade-out from the centre to the cor-
ners

CURTAIN UP fade-out from the bottom to the top

CURTAIN DOWN fade-out from the top to the bottom

SCROLL LEFT  scroll-out to the left

SCROLL RIGHT
VOPEN

scroll-out to the right
fade-out from the centre to the top
and to the bottom

VCLOSE fade-out from the top and the bot-
tom to the centre

SCROLL UP scroll-out to the top

SCROLL DOWN  scroll-out to the bottom

HOLD the text stays on the display

L

Press [1] or [{] to select the display time (0.5 to
25 seconds) for the text and then press [ENTER]
to confirm. “SPEEDOQ” is displayed.

10) Press [1] or [{] to select the fade-in/fade-out
speed (0 to 3) and then press [ENTER] to con-
firm. The message is saved and can be dis-
played (1= chapter 4.1.5).
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@ 4.1.5 Displaying messages
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To display one or multiple messages that have
been saved:

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press the button [RUN-PAGE].

3) Use the buttons [A] to [Z] to enter the storage
locations of the messages in the order in which
they are to appear on the display. Use the but-
ton [DEL] to correct wrong entries.

4) Press [ENTER] to complete the entry.

All messages selected are briefly displayed and
then repeatedly appear on the display according to
the parameters that have been defined. If a storage
location does not contain any message, the error
message “EMPTY Page” will be displayed.

4.1.6 Time-controlled display

Five independent programs allow for the automatic
display of saved messages at specific times. To
create a program:

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press the button [PROG]. “PROG (T/i/=/<)" is
displayed.

3) Press [{] twice. The program location “SCH A”
is displayed.

4) Press [—]. “A” is displayed in bold.

5) Press [1] or [{] to select the storage location
(A to E) and then press [ENTER] to confirm.
“SYRO00” (= starting year) is displayed.

6) Set the year for the start time. Press [1] or [{]
to set the individual digits and press [«] or [-]
to go to another position. Press [ENTER] to
confirm.

Proceed in the same way to enter the month
“SMQ”, the day “SDY”, the hour “SHR” and the
minute “SMI” for the start time.

Then proceed in the same way to enter the
year “TYR”, the month “TMQO?”, the day “TDY”,
the hour “THR” and the minute “TMI” which
define the point of time until which the display is
to be shown.

.

An asterisk * is displayed. Use the buttons [A]
to [Z] to enter the storage locations of the mes-
sages in the order in which they are to appear
on the display. Use the button [DEL] to correct
wrong entries.

8) Press [ENTER] to complete the entry.

4.1.7 System settings

4.1.7.1 Setting date and time

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press the button [FUNCT]. “SETUP (T{—<)"is
displayed.

3) Press [{] repeatedly until “YR:” is displayed.

4) To change the number of the year, press [~].
Set the number of the year. Press [1] or [{] to set
the individual digits and press [«] or [->] to go to
another position. Press [ENTER] to confirm.

5) Press [{]; “MTH” is displayed. To change the
month, press [-], set the month and then press
[ENTER] to confirm.

6) Press [{]; “DAY” is displayed. To change the
day, press [], set the day and then press
[ENTER] to confirm.

7) Press [{]; “HR:” is displayed. To change the
hour, press [-], set the hour and then press
[ENTER] to confirm.

8) Press [{]; “MIN” is displayed. To change the
minute, press [~], set the minute and then press
[ENTER] to confirm.

9) Press [ESC] to exit the setting menu.

The setting can be cancelled at any time with
[ESC].

4.1.7.2 Changing the brightness

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press [FUNCT]. “SETUP (T{—«)”is displayed.

3) Press [{] repeatedly until “BR:” is displayed.

4) To change the brightness, press []. Press [1]
or [{] to select the brightness: A = 100 %,
B=75%,C=50%,D=25%

Press [ENTER] to confirm.
5) Press [ESC] to exit the setting menu.

The setting can be cancelled at any time with
[ESC].

4.1.7.3 Changing the unit address (IP)

To distinguish multiple units, each unit may be

assigned an individual ID/address:

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press the button [FUNCT]. “SETUP (T{—<)"is
displayed.

3) Press [{] repeatedly until “ADD” along with the
current address is displayed.



4) To change the address, press the button [-].
Press the button [1] or [{] to adjust a digit (hexa-
decimal) or press [«] or [-] to go to another
position. Press [ENTER] to confirm.

5) Press [ESC] to exit the setting menu.

The setting can be cancelled at any time with
[ESC].

4.1.7.4 Resetting the display

All display settings can be reset to their factory set-

tings. This will delete all messages, display pro-

grams and settings the user may have defined. The

clock setting and the unit address, however, will be

kept.

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press the button [FUNCT]. “SETUP (T{—><«)"is
displayed.

3) Press [{]. “CLEAR ALL Y?” is displayed.

4) To reset to the factory settings, press [ENTER]
or, to cancel the procedure, press [ESC].

4.2 Operation via a computer
Start the control program NewSign[...].EXE on the
PC. The window “Sign Color” (1= fig. 2) appears.

1) Select the display type used:
TRIPLE COLOR for PML-100COL/-70COL or
SINGLE COLOR for PML-100R/-60R.

2) If this selection shall not have to be made every
time the program is started, remove the tick next
to “Show when program starts” (this setting can
also be made via the program menu: “Func-
tions” » Show Color Setting...”).

3) Click “OK” to close the window.

Sign Color,

X
c trpecotor P g @ simeie coor [

[v Show when program startz

Cancel

@ Window “Sign Color”

4.2.1 Setting the interface

Select the appropriate interface so that the pro-
gram can transfer data to the display.

1) Activate the menu item File » Set COM... and
then, from the list, select the number of the inter-
face that the USB driver simulates for the pro-
gram.

2) Click “OK” to confirm.

The appropriate settings of the operating system
can, for example, be found under » Control Panel
» System Properties (Hardware) # Device Manager
» Ports (COM and LPT).
It reads, for example: “USB to UART [...] (COMS3)”
If the computer has assigned a COM number higher
than 8 to the interface, the COM number must be
manually changed to a number between 1 and 8
(e. g. via » Properties # Port Settings » Advanced ...).
The transmission parameters must be set for the
interface as follows (e.g. via » Properties » Port
Settings):

bits per seconds: 9600

data bits: 8

parity: none
stop bits: 1

flow control: Xon/Xoff

4.2.2 Entering a message and
transferring it to the display

In the text window, enter the text to be displayed
(1= fig. 3). The bottom of the window indicates the
number of characters that have been entered. If the
user tries to enter more than 210 characters, a
message will appear informing the user that the
maximum number of characters has been reached.

Hew Sign €] @F‘S_?I
File Edit Commands European Fonkt Color  Bmp Graphics Functions  Help
DEHE & 28 F 2
Line 1
«<Scoll Left> <Fontdx7>Text - text - texte

<Inversed Red>- testo - texto - tekst
<U00> <3Sec><Scroll Down >

102

@ Main window with text

The menu allows the user to include formatting
instructions (1=° chapter 4.2.3), special characters
(r=>> chapter 4.2.4), date and time (1= chapter 4.2.5),



(GBJ graphics (1> chapter 4.2.6) or fade-in, fade-out or
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display effects (1= chapter 4.2.7). The formatting
instructions (shown in red and included in angle
brackets) define how the text is to be displayed. To
modify a formatting instruction, either change the
appropriate parameter (if known) in the angle
brackets or delete the formatting instruction along
with its angle brackets and add a new formatting
instruction via the menu.

As with other programs (e. g. word processing),
the menu or the appropriate icon in the toolbar
allows the user to copy marked passages of text
(Edit » Copy/ Bg), cut them (Edit # Cut/ % ) or delete
them (Edit » Delete). Copied or cut passages of text
can be inserted (File » Paste/@).

To transfer the entered message to a display that is
connected to the same computer:

1) Activate the menu item “Function » Send Mes-
sage...” or click the appropriate button % . The
window “Send Message” appears (=5 fig. 4).

Send Message @

Sign ID oo -
Page: r -

@ Window “Send Message”

2) Select the unit ID (Sign ID) (“00” will select all
units) and the storage location (page) for the
text and then click “OK” to confirm. The mes-
sage is saved on the display.

Transferring messages via a computer network
15 chapter 4.2.9.

4.2.3 Text formatting

Unlike the text entry via remote control where the
formatting always applies to the entire text, text
entry via the computer allows the user to change
the formatting within the text by including the
appropriate formatting instruction at the text loca-
tion desired.

Use the menu “Font” to change the font style
(standard: 5x7, condensed: 4 x7 or bold: 6x7);
use the menu “Color” to change the text colour and/
or background colour.

4.2.4 Special characters

Special characters that cannot be directly entered
via the keyboard may be inserted via the menu:

1

)

Activate the menu item “European » European
Char”. The window “European Char Form” with
a character map appears (1= fig. 5).

2) Click the special character desired. The code is
shown right next to the character.

3) Click “Insert” to insert the code of the special
character into the text.

4) If required, select additional special characters
and insert them into the text.

5) Click “Cancel” to close the window.
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@ Special character map

4.2.41 User-defined special characters
If the special characters desired are not included in

the character map, users may define up to 64 char-
acters of their own.

1) Activate the menu item “European » User Font
Make...”. The window “Font Make” appears
(1= fig. 6).

Font Make

File  Transfer

- BIX

Char Code, L40 hd

Width 4 Height: 7

Forit Size: | 457 | Pixels

4 | x|

Draw Font

Position; (3, 0)

@ Window “Font Make”



2) From the list “Char Code”, select the character
code for the new character. In the character
map (=5 fig. 5), the new character will replace
the character that was previously assigned to
the code selected.

&L

From the list “Font Size”, select the font style for
which the character is to be created.

K

Use the button 4 to add an entry to the list.

o

Click this new list entry. A grid with the size of the
font style selected appears on the right-hand
side of the window.

2

Click the fields of the grid to add or delete pixels.

J

To delete all pixels, click “NO”. To adopt the
character, click “Yes”. A miniature sample of the
character is now shown next to the list entry.

*

To create the character for another font style,
repeat this procedure from step 3) onwards. To
create another character, repeat this procedure
from step 2) onwards.

L

To delete a list entry, select the appropriate list
entry, click the button X located above the list
and then confirm the confirmation message.

10) To transfer all created special characters to the
display, activate the menu item “Transfer
» Transfer to Sign...”. The window “Transfer
Font To Sign” appears.

11) From the list “Sign ID”, select the address of the
display (or “00” to select all displays) and then
either click “Transfer” to start the transfer or click
“Cancel” to cancel the procedure.

12) All user-defined special characters can be
saved on the computer via the menu item “File
» Save Font...” and can be loaded via the menu
item “File » Open Font...”.

13) Use the menu item “File » Quit” to exit the win-
dow “Font Make”.

4.2.4.2 Resetting special characters

All user-defined characters may be replaced by the
predefined special characters:

1) Activate the menu item “European » Recall
Default Font”. The window “Confirm” appears.

2) From the list “Sign ID”, select the address of the
display (or “00” to select all displays) and then
either click “Yes” to start the transfer or click
“No” to cancel the procedure.

The special characters both in the storage of the
display and in the map “European Char Form” are
reset to the predefined settings (1= fig. 5).

4.2.5 Displaying date or time, reproducing an
acoustic signal

To insert the current time into a text, activate the

menu item “Commands # Special Function » Time”.

To insert the current date, activate the menu item

“Commands # Special Function » Date”.

For an acoustic signal to sound while the mes-
sage is being displayed, activate the menu item
“Commands # Special Function » Bell »”; in the last
menu branch, select the duration of the acoustic
signal: 0.5 to 2 seconds.

4.2.6 Graphics

In addition to text, plain graphics can be displayed.
Users can import graphics or create their own
graphics with the program. Up to 16 graphics can
be loaded into a display:

1) Activate the menu item “Bmp Graphics » Edit
Graphic...” The window “Graphic Form”

appears (1= fig. 7).

GraphicForm

Select Graph - Graphic Size ToalBox
GOT

[fots =] win  [fdns -]

G0z Height

*s
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*e

et | [

pete |

@ Window “Graphic Form”

2) Select the height and the width for the graphic.
The maximum graphic size is equal to the size
that can be shown on the display.

3) To change the size of the view, use the field
beneath “Zoom” (1 x...8x).

k=

Click one of the circles beneath “Color” to select
the colour desired. The colour currently se-
lected is shown in the square right above the cir-
cles.

o

Under “Toolbox”, the following graphic drawing
functions are available:

g point or freehand line, thin
@ freehand line, thick

N straight line

| rectangle

GE]
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u rectangle, filled
Q ellipse
® clipse, filled

- selection frame, rectangle
left mouse button to move the selection
frame; right mouse button: to insert the se-
lection frame

2 selection frame, freehand
left mouse button to move the selection
frame; right mouse button: to insert the se-
lection frame

pixel deletion

add text:

1. click in the graphic area

2. enter text

3. select the font “Font Selection [...]”
4. define the height

5. click “OK” to confirm

6. position with the left mouse button
7. insert with the right mouse button

N

¥ colour fill of the entire graphic

To delete all pixels you have drawn, click
“Clear”.

Click “Bmp...” to open the window “Bmp Save
Load”. This window provides: the option “Export
Bmp...” which allows users to export a bitmap
file to the computer; the option “Import Bmp...”
which allows users to import a bitmap file.

To save a graphic so that it can be used on the
display, click “Save”. In the window “Select
Graphi Name”, select the storage location (GO0
to G16) for the graphic and then click “OK” to
confirm. If a graphic has already been saved
with this number, a warning message will
appear. Click “Yes” to confirm the overwrite or
“No” to cancel.

To edit a graphic, select the appropriate graphic
number from the list “Select Graph”.

To delete a graphic saved, select the appropri-
ate number from the list “Select Graph” and then
click “Delete”. A confirmation message appears;
to confirm the deletion, click “Yes”, or, to cancel
the procedure, click “No”.

To insert a graphic saved into a message, select
the appropriate graphic number from the list
“Select Graph” and then click “Insert”. A graphic
reference is inserted in the text window
(1= fig. 3) and the window “Graphic Form” is
closed.

4.2.7 Fade-in and fade-out effects,

display options
Many options are available to facilitate an attractive
and varied display design, i. e. users can, for exam-
ple, define how the text appears, how long it is
shown and how is disappears (description of the
fade-in and fade-out effects 1= chapter 4.1.4).

1) To define the fade-in effect, activate the menu
item “Commands # Leading Effect »”; in the last
menu branch, select the type of the effect and
then insert it at the beginning of the message.

Note: If the text is longer than the display, use the fade-
in effect “SCROLL LEFT” to show the entire text.

The options

“Leading Effect » Welcome » Hello World” and
“Leading Effect » Welcome » Welcome”

will display predefined welcome texts instead of
a text entered.

If no fade-in effect is defined, “Scroll Left” will be
applied by default.

To define the speed of the fade-in and fade-out
effect, activate the menu item “Commands
» Move Speed...”. In the window “Move Speed”,
set the speed between slow (0) to fast (3) and
then click “OK” to confirm.

If no speed is defined, “fast” will be applied by
default.

)

L

Activate the menu item “Commands » Display
Effect #”; in the last menu branch, define if the
message shall be blinking or not (“Normal” =
default).

To define the duration of the message display,
activate the menu item “Command # Display
Time...”. In the window “Move Speed”, set the
display duration (0.5 to 25 seconds) and then
click “OK” to confirm.

If no display duration is defined, a duration of
1 second will be applied by default.

k=

5) If a message is to be displayed with a cer-
tain offset from the left border, activate the
menu item “Commands » Special Function
» Column...”. In the window “Set Starting Col-
umn”, set the offset desired (number of LED
columns), click “OK” to confirm and insert the
offset before the appropriate text.

To define the fade-out effect, activate the menu
item, “Commands # Closing Effects »”; in the last
menu branch, select the type of effect and insert
it at the end of the message.

If no fade-out effect is defined, “Scroll Left” will
be applied by default.

=)



4.2.8 Saving, loading or creating a message
As with other programs (e. g. word processing), the
menu or the appropriate icon in the toolbar allows
the user to save created messages on the com-
puter (File » Save.../ [d), load saved messages
(File ® Open.../ &) or create a new message (File
» New/ [3).

The file extension “.nsn” is automatically ap-
pended while the messages are being saved.

4.2.9 Sending a message via a network

If the display is connected to a computer which is
part of a network, another computer on the network
will be able to send a text to the display. For this
purpose, the display must be defined as the local
printer on the computer to which the display is con-
nected.

— Use the standard driver “Generic/Text Only” as
the printer driver.

— Select the COM port that simulates the driver for
the program as the interface (1=° chapter 4.2.1).

— In the “Printer Properties”, select the option
“Print directly to the printer” so that print jobs are
not processed by the printer spooler of the oper-
ating system.

— Share the printer with the network so that it can
be accessed by other computers on the network.

Every computer on the network on which the pro-
gram is installed can now send a text to the display:

1) Start the program.

2) Enter the text desired into the text field
(1= chapter 4.2.2) or load it from a file (1=° chap-
ter 4.2.8).

3) Click the icon %, “Send via Network” located
above the text field.

4) Select the unit address “Sign ID” (“00” will select
all units) and the storage location “Page” for the
text and then click “OK” to confirm.

5) In the window “Print”, select the name of the
printer created and then confirm your selection.

The text on the display will be immediately updated

if the display is currently showing the message of

the storage location selected.

4.2.10 Displaying messages

To call up one or more messages saved on the dis-

play:

1) Activate the menu item “Functions # Link Pages
To Run...”. The window “Link Pages” appears
(1= fig. 8).

Link Pages @

Sign 1D ul1] -

Page: [e.g. abcED]

|abacadeeafz

oK

Window “Link Pages”

2) Select the unit ID from the list “Sign ID” (“00” will
select all units).

3) In the field beneath “Page”, enter the storage
locations of the messages in the order in which
the messages are to be shown on the display
(@...zorA...Z).

4) Click “OK” to confirm. The instructions are trans-
ferred to the display and executed there.

Once the transmission has been completed, a con-
firmation message appears.

It is also possible to display a single message via
the menu item “Functions » Run Page...”.

4.2.11 Time-controlled message display

Five independent programs allow for the automatic
display of saved messages at specific times.

1) Activate the menu item “Functions # Display by
Schedule...”. The window “Schedule” appears
(= fig. 9).

Schedule

WO | End DateTime | Page
08/221310:20  ACE
08/241310:20  ACE
08/2641310:20  DEF
08/281310:20 G

08/301310:20 W2

Start DateTime
08/191317:20
08/231317:20
08/25/1317:20
08/271317:20
08/231317:20

]
2
3
4
5

Modify.. | Delete ‘

- Send

SignID: |00

(9) Window “Schedule”
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2) To add a new display program, click “Add...”

The window “Schedule-Add” appears (1= fig. 10).

If the user tries to create more than 5 pro-
grams, an error message will appear.

Schedule-Add X
Start DateTime

MM /DDA

Date:  |08/20/13
Time : [11:55

End DateTime
(MM /DDA

Date: (08/20/13
Time: |12:55
Page |adegH

[e.g: abcDE )
0K |

Cancel ‘

Window “Schedule-Add”

3) Under “Start Date Time”, enter the date and the
time for the start of the display period desired.
Observe the format (month/day/year — each
with two digits) when entering the date.

4) Under “End Date Time”, enter the date and the
time for the end of the display period desired.

)

In the field “Page”, enter the storage locations of
the messages in the order in which the mes-
sages are to be shown on the display (a ... z or
A...2).

Click “OK” to confirm your entries. The display
program is now included in the table (1= fig. 9).

2

Note: The table does not include the programs of the
display storage; it only includes the programs that have
been created since the PC software was started.

7) If desired, add further display programs
(1= step 2).

8) To change a display program, select the appro-
priate program from the table and click “Mod-
ify...”. In the window “Schedule Modify”, change
the data and then click “OK” to confirm your
changes or click “Cancel” to reject them.

9) Select the unit address from the list “Sign ID”
(“00” will select all units).

10) Click “Send” to transfer the data to the display.
Programs that already exist in the display stor-
age will be overwritten. Once the transmission
has been completed, a confirmation message
will appear.

4.2.12 System settings

4.2.12.1 Setting date and time
1) Activate the menu item “Functions # Set Clock...”.
The window “Set Clock” appears.

2) Select the unit address from the list “Sign ID”
(“00” will select all units).

3) Next to “Date”, enter the date, and next to
“Time”, enter the time.

4) Click “OK” to confirm your entries, or click “Can-
cel” to cancel the procedure.

Once the transmission has been completed, a con-
firmation message will appear.

4.2.12.2 Changing the brightness
1) Activate the menu item “Functions » Set Bright-
ness...”. The window “Set Brightness” appears.

2) Select the unit address from the list “Sign ID”
(“00” will select all units).

3) Select the brightness desired from the list
“Brightness” (100 %, 75 %, 50 %, 25 %).

4) Click “OK” to confirm your entries, or click “Can-
cel” to cancel the procedure.

Once the transmission has been completed, a con-
firmation message will appear.

4.2.12.3 Changing the unit address (ID)

1) Activate the menu item “Functions » Set ID...”.
The window “Set Sign ID” appears.

2) Select the future unit address from the list
“Sign ID” and click “OK” to confirm.

3) In the confirmation window, click “Yes” to con-
firm your selection, or click “No” to cancel the
procedure.

Once the transmission has been completed, a con-
firmation message will appear.

4.2.12.4 Deleting messages from the display

1) Activate the menu item “Functions » Delete
Page...”. The window “Delete Page” appears.

2) Select the unit address from the list “Sign ID”
(“00” will select all units).

3) Tick the boxes next to the storage locations
(page A to page Z) that are to be deleted from
the display.

4) Click “OK” to confirm your selections, or click
“Cancel” to cancel the procedure.

Once the transmission has been completed, a con-

firmation message will appear.



4.2.12.5 Deleting display programs from the display

1) Activate the menu item “Functions » Delete
Schedule...”. The window “Delete Schedule”
appears.

2) Select the unit address from the list “Sign ID”
(“00” will select all units).

3) Tick the boxes next to the display programs that
are to be deleted from the display.

4) Click “OK” to confirm your selections, or click
“Cancel” to cancel the procedure.

Once the transmission has been completed, a con-
firmation message will appear.

4.2.12.6 Resetting the display

To delete all the messages, display programs and
settings (except the time setting and the unit
address) the user has saved on the display:

1) Activate the menu item “Functions » Delete
All...”. The window “Delete All” appears.

2) Select the unit address from the list “Sign ID”
(“00” will select all units).

3) Click “OK” to confirm your selection, or click
“Cancel” to cancel the procedure.

Once the transmission has been completed, a con-
firmation message will appear.

All rights reserved by MONACOR® INTERNATIONAL GmbH & Co. KG. No part of this instruction manual may

5 Specifications
Number of LEDs

PML-100COL: ........ 840, red/green
PML-100R: .......... 840, red
PML-70COL: ......... 560, red/green
PML-60R: ........... 560, red

Power supply: .......... 12 V=, via power sup-

ply unit provided
and connected to
230 V~/50 Hz

Dimensions
PML-100R, -100COL.: ..
PML-70COL, -60R: . ...

1000 x 110 x 45 mm
700 x 110 x 45mm

Weight
PML-100R, -100COL: .. 2kg
PML-70COL, -60R: .. .. 1.2kg

Subject to technical modification.

be reproduced in any form or by any means for any commercial use.
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